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1 Visualizing

In this seminar we will be looking at various interactions between mathematics and visual-
ization. Some examples are:

1. Illustrating mathematical structures

2. Illustrating mathematical theorems

3. Illustrating mathematical proofs

4. Simulations

5. Using mathematics to create images

6. Using mathematics to create animations

Some examples of visualization media:

1. Physical models

2. Computer models

3. Physical movement

4. Music and visual art

5. Literature

6. Videos

This set of notes will evolve dynamically as the course progresses. Here is the course website:
www.ms.uky.edu/~lee/visual05/visual05.html.

2 Examples of Visualizations and “Snapshots”

Look at some of the examples on the course website.
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3 Some Polyhedron Problems

Polyhedra provide fruitful fodder for physical and virtual mathematical models. Here are
some problems to get started. It will be helpful to have construction materials like Polydron.

1. Try to find (construct) convex polyhedra such that every face is an equilateral triangle
and adjacent triangles do not lie in the same plane. (The polyhedron is convex if the
entire line segment joining any two points of the polyhedron lies within the polyhedron.)
These are the deltahedra. What do you notice about the numbers of faces of the
polyhedra constructed? Make some conjectures. Try to find some proofs.

2. Consider clusters of regular polygons that fit together around a common vertex (cor-
ner), but with a total angle sum of less than 360 degrees. Let’s call these space clusters.
For example, the cluster of three squares, which can denote (4, 4, 4), makes a total angle
of only 270 degrees. Of course, this cluster can be extended so that the same cluster
appears at each vertex, eventually closing up to make a cube. Some space clusters
cannot be extended to create a polyhedron. The space cluster (4, 4, 4, ) consists of
only one type of polygon, as opposed to, say (3, 4, 3, 4)—“triangle, square, triangle,
square”—which consists of more than one type of polygon. Find as many space clus-
ters as you can that can be extended to enclose a polyhedron. If the cluster contains
only one type of polygon, the resulting polyhedron is called a Platonic solid or regular
polyhedron. If the cluster contains a mixture of two or more polygons, the result-
ing polyhedron is called an semiregular polyhedron. There are two infinite families of
semiregular polyhedra—the prisms and the antiprisms. Besides theses there are just
13 others, known as the Archimedean solids.

3. Try to find coordinates for the vertices of some of these polyhedra.

4 Cartesian Coordinates

You are probably already familiar with two- and three-dimensional Cartesian coordinate
systems. The typical view of the three-dimensional coordinate system is usually something
like this:
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Points, or locations, are ordered triples (x, y, z) of numbers. To find the point associated
with the triple, begin at the origin (0, 0, 0), move x units in the direction of the positive
x-axis (move backwards if x is negative), y units in the direction of the positive y-axis, and
z units in the direction of the positive z-axis.

It is sometimes useful to specify the location of a point with respect to two others. For
example, if we are given the coordinates of points A and B and t is a real number, then
C = (1 − t)A + tB is a point on the line through A and B. This is the parametric form of
the line. If t = 0 then we get the point A. If t = 1 then we get the point B. If t = 0.5 then
we get the midpoint of the segment joining A and B. If t = 1/3 then we get the point one
third of the way from A to B. If t = 3 then we get the point three times as far from A than
B.

The distance between two points A = (x1, y1, z1) and B = (x2, y2, z2) is given by the
distance formula

d(A,B) =
√

(x2 − x1)2 + (y2 − y1)2 + (z2 − z1)2.

This is really a manifestation of the Pythagorean Theorem, which may be more obvious to
you if you look at the distance formula in the plane.

Another useful formula, used for solving quadratic equations ax2 + bx + c = 0, is the
quadratic formula:

x =
−b ±√

b2 − 4ac

2a
.
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5 Introduction to POV-Ray

POV-Ray is powerful, yet free, ray-tracing software that can produce beautiful three-
dimensional images. Download the software from the website www.povray.org. It is avail-
able for Windows as well as the Mac operating systems. The syntax can be intimidating,
but with practice one can fairly quickly begin producing some nice images. Download some
of the examples from the course website, and study them to see what the instructions are
doing.

After POV-Ray is installed and started up, do the following to render a test scene:

1. Go to the course website, select “POV-Ray Examples”, and then select “Source file”
under “Sphere”. Use “Edit—Select All” and then “Edit—Copy”.

2. Within POV-Ray select “File—New File”. Then select “Edit—Paste”.

3. Select “File—Save” to save the file somewhere on your computer.

4. Select your desired picture size, such as “[512x384, AA 0.3]” from the pulldown menu.

5. Select “Render—Start Rendering (Go!)” to create the picture. If all goes well, you
should see a resulting image.

We’ll come to animations later.

6 Coordinates for the Platonic Solids

Let’s form a cube so that the two opposite vertices, A and G, below, have coordinates
A = (−1,−1,−1) and G = (1, 1, 1). Determine the coordinates of the remaining vertices.

You can view this picture as a Wingeom file cube.wg3. If you have a computer with a
Windows operating system go to the website http://math.exeter.edu/rparris/wingeom.html
and download Wingeom (click “Wingeom” in the upper left corner). Click the downloaded
file to install it. Then download the file cube.wg3 from the course website. Start the program
Wingeom. Select “Window→3-dim”. Select “File→Open”. Select the file cube.wg3. You
can then use the arrow keys to turn it around.
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Now you can construct a regular tetrahedron by using “every other” vertex of the cube.
Download and view the file tetrahedron.wg3.

The vertices of an octahedron can be taken to be the centers of the six squares of the
cube. The following comes from the file octahedron.wg3.
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The icosahedron is trickier. First, center six line segments in each of the six faces of the
cube as shown below. For example, the coordinates of the points I and J will be I = (t, 0,−1)
and J = (−t, 0,−1), where t is a positive number between 0 and 1 yet to be determined.
Similarly, the coordinates of the points K and L will be K = (0,−1, t) and L = (0,−1,−t)
for the same value of t. The following comes from the file preicosahedron.wg3.
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The goal is to determine the value of t so that when the points are joined as shown below,
each of the resulting triangles is equilateral. Use algebra to calculate the exact value of t.
The picture comes from the file icosahedron.wg3. When you open this file from Wingeom,
you can move the “# slider” to observe the effect of changing t.

Once you have the coordinates of the vertices of the icosahedron, the vertices of the
dodecahedron can be taken to be the centers of each of the icosahedron’s triangles. You can
get the coordinates of such a center point by averaging each of the coordinates of the vertices
of the triangle. The following comes from the file icosahedron2.wg3.
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7 Trigonometry

7.1 Basic Results

Nearly all that we will need to know about trigonometry can be derived by carefully thinking
about the unit circle. A circle of radius one is called a unit circle. A unit circle with center at
the origin of the Cartesian plane is often called the unit circle. The trigonometric functions
can be defined using the unit circle.

Let α be the measure of an angle. Place a ray r from the origin along the x axis as shown
below.
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If α ≥ 0, rotate the ray by α degrees in the counterclockwise direction.
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If α < 0, rotate the ray by |α| radians in the clockwise direction.
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Determine the point (x, y) where r intersects the unit circle. We define

cos α = x

and
sin α = y.

Exercise 7.1 1. Use the definitions for the sine and cosine functions to evaluate sinα
and cos α when α equals

(a) 0

(b) 90 degrees

(c) 180 degrees

(d) 270 degrees

(e) 360 degrees

(f) 60 degrees

(g) 45 degrees

(h) 30 degrees

(i) 60n degrees for all possible integer values of n
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(j) 45n degrees for all possible integer values of n

(k) 30n degrees for all possible integer values of n

2. Drawing on the definitions for the sine and cosine functions, sketch the graphs of the
functions f(α) = sin α and f(α) = cos α, and explain how you can deduce these
naturally from the unit circle definition,

3. Continuing to think about the unit circle definition, complete the following formulas
and give brief explanations for each.

(a) sin(−α) = − sin(α).

(b) cos(−α) =

(c) sin(180 + α) =

(d) cos(180 + α) =

(e) sin(180 − α) =

(f) cos(180 − α) =

(g) sin(90 + α) =

(h) cos(90 + α) =

(i) sin(90 − α) =

(j) cos(90 − α) =

(k) sin2(α) + cos2(α) =

Exercise 7.2 Open the file Unitcircle.wg2 within a Wingeom 2-dimensional window. As
you slide the point C around the circle, its coordinates are displayed. Remember, the first
coordinate is the cosine of the angle, and the second coordinate is the sine of the angle,
made by the ray with the x-axis. Use this to confirm some of your answers to the previous
exercises. You may also want to look at the files Negative.wg2 and Complement.wg2 for
visualizations of sines and cosines of negatives and complements of angles, respectively.

Exercise 7.3 Use the sine and cosine functions to determine the coordinates of the vertices
of:

1. A regular pentagon with vertices having a distance of 1 from the origin.

2. A regular heptagon with vertices having a distance of 3 from the origin.

3. A regular n-gon with vertices having a distance of r from the origin.
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Exercise 7.4 Here is perhaps a more familiar way to define sine and cosine for an acute
angle α: Take any right triangle for which one of the angles measures α. Then sin α is the
ratio of the lengths of the opposite side and the hypotenuse, and cosα is the ratio of the
lengths of the adjacent side and the hypotenuse. Explain why this definition gives the same
result as the unit circle.

7.2 Applications to Triangles

Exercise 7.5 Now let’s put some algebra and trigonometry to use to develop some useful
formulas. In this problem we will use the triangle pictured below. In this triangle all angles
have measure less than 90◦; however, the results hold true for general triangles.

The lengths of BC, AC and AB are a, b and c, respectively. Segment AD has length c′

and DB length c′′. Segment CD is the altitude of the triangle from C, and has length h.

a

A

C

BD

b
h

c

c’ c’’

The usual formula for the area of a triangle is 1
2
(base)(height), as you have recently

confirmed.

1. Prove that area (�ABC) = 1
2
bc sin A.

2. What is a formula for area (�ABC) using sin B? Using sin C? (Note: you will have
to use the altitude from A or B).

3. What is the relationship of these formulas to the SAS congruence criterion?

Exercise 7.6 Using the same triangle, the Law of Sines is:

sin A

a
=

sin B

b
=

sin C

c
.
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The result holds for arbitrary triangles, but we shall prove it for our triangle �ABC.

1. We showed that the area of this triangle was given by three different formulas. What
are they?

2. From these three formulas, prove the Law of Sines.

Exercise 7.7 Using the above triangle, the Law of Cosines is:

a2 = b2 + c2 − 2bc cos A.

1. Prove that c′ = b cos A.

2. Observe that c′′ = c − c′.

3. Verify that h2 = b2 − (c′)2.

4. Apply the Pythagorean Theorem to triangle �CDB, then use the facts above to make
the appropriate substitutions to prove the Law of Cosines.

5. What happens when you apply the Law of Cosines in the case that � A is a right angle?

Exercise 7.8 Suppose for a triangle you are given the lengths of the three sides. How can
you determine the measures of the three angles?

Exercise 7.9 Suppose for a triangle you are given the lengths of two sides and the measure
of the included angle. How can you determine the length of the other side, and the measures
of the other two angles?

Exercise 7.10 Suppose for a triangle you are given the measures of two angles and the
length of the included side. How can you determine the measure of the other angle, and the
lengths of the other two sides?

Exercise 7.11 Assume that you have triangle �ABC such that the coordinates of the
three (distinct) points A, B, and C are (0, 0), (x1, y1), and (x2, y2), respectively. The Law
of Cosines can be used to prove that

cos A =
x1x2 + y1y2√

x2
1 + y2

1

√
x2

2 + y2
2

.

Use the Law of Cosines to prove this formula. Recall that the length of a line segment

joining points (x1, y1) and (x2, y2) is
√

(x2 − x1)2 + (y2 − y1)2. The numerator of the right-
hand side of this formula is called the dot product of A and B.
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Exercise 7.12 The above formula extends naturally into three dimensions. Assume that
you have triangle �ABC such that the coordinates of the three (distinct) points A, B, and
C are (0, 0, 0), (x1, y1, z1), and (x2, y2, z2), respectively. The Law of Cosines can be used to
prove that

cos A =
x1x2 + y1y2 + z1z2√

x2
1 + y2

1 + z2
1

√
x2

2 + y2
2 + z2

2

.

Use the Law of Cosines to prove this formula. The numerator of the right-hand side of
this formula is called the dot product of A and B.

Exercise 7.13 Referring again to the triangle �ABC in the plane, we can prove another
area formula.

area (�ABC) =
1

2
|x1y2 − x2y1|

Use area (�ABC) = 1
2
bc sin A, the cosine formula from the previous exercise, and sin2 A+

cos2 A = 1 to prove this formula.

Exercise 7.14

1. Consider triangle �ABC in the figure below. First, rescale point C by a positive
number k to get a point C ′ = (x′

2, y
′
2) on the same circle as B. Use rectangles to show

that x1y
′
2 > x′

2y1.
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2. Now use algebra to show that x1y2 > x2y1.

3. Conclude that the area of triangle �ABC is 1
2
(x1y2 − x2y1).

(In fact, this formula is true as long as the angle (with measure at most 180 degrees) between
AB and AC occurs as a counterclockwise rotation from AB toward AC.)

Exercise 7.15 Consider any simple polygonal region (the boundary does not cross itself)
in the plane, and assume that the vertices occurring in counterclockwise order around the
perimeter have coordinates P1(x1, y1), P2(x2, y2), . . . , Pn(xn, yn). It turns out that the area
of this region is given by

1

2
[(x1y2 − x2y1) + (x2y3 − x3y2) + · · · + (xn−1yn − xnyn−1) + (xny1 − x1yn)].

Can you explain why this formula works?

7.3 Rotation Formulas

Exercise 7.16 The next few exercises will develop the matrix for a general rotation.
Assume that A and B are two points on the unit circle centered at the origin, with

respective coordinates (x1, y1) and (x2, y2). Draw the line segments OA and OB. Let α be
the angle that OA makes with the positive x-axis, and β be the angle that OB makes with
the positive x-axis.
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1. From Exercise 7.11 we know that

cos(� AOB) =
x1x2 + y1y2√

x2
1 + y2

1

√
x2

2 + y2
2

From this, prove that

cos(β − α) = cos α cos β + sin α sin β.

2. Replace α with −γ and β with δ to prove

cos(γ + δ) = cos γ cos δ − sin γ sin δ.

3. Replace γ with 90 − γ and δ with −δ to prove

sin(γ + δ) = sin γ cos δ + cos γ sin δ.

The above two formulas are the trigonometric angle sum formulas.

Exercise 7.17 Now assume that point A has coordinates (x1, y1) = (r cos γ, r sin γ) and
we wish to rotate it by δ about the origin, obtaining the point B = (x2, y2) = (r cos(γ +
δ), r sin(γ + δ)).
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Prove the rotation formula:

(x2, y2) = (x1 cos δ − y1 sin δ, x1 sin δ + y1 cos δ).
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8 A Brief Introduction to Fractals

8.1 The Fractal Nature of Nature

Exercise 8.1 The notion of “length” of certain naturally occurring objects can, however,
be tricky, and can lead one into the notion of fractals. The following quote comes from a
book by Mandelbrot. Read this quote and then explain how you think measurements of
lengths of coastlines are calculated in practice.

To introduce a first category of fractals, namely curves whose fractal dimension
is greater than 1, consider a stretch of coastline. It is evident that its length is at
least equal to the distance measured along a straight line between its beginning
and its end. However, the typical coastline is irregular and winding, and there is
no question it is much longer than the straight line between its end points.

There are various ways of evaluating its length more accurately. . . The result
is most peculiar: coastline length turns out to be an elusive notion that slips
between the fingers of one who wants to grasp it. All measurement methods
ultimately lead to the conclusion that the typical coastline’s length is very large
and so ill determined that it is best considered infinite. . . .

Set dividers to a prescribed opening ε, to be called the yardstick length, and walk
these dividers along the coastline, each new step starting where the previous step
leaves off. The number of steps multiplied by ε is an approximate length L(ε).
As the dividers’ opening becomes smaller and smaller, and as we repeat the
operation, we have been taught to expect L(ε) to settle rapidly to a well-defined
value called the true length. But in fact what we expect does not happen. In the
typical case, the observed L(ε) tends to increase without limit.

The reason for this behavior is obvious: When a bay or peninsula noticed on
a map scaled to 1/100, 000 is reexamined on a map at 1/10, 000, subbays and
subpeninsulas become visible. On a 1/1, 000 scale map, sub-subbays and sub-
subpeninsulas appear, and so forth. Each adds to the measured length.

—B.B. Mandelbrot, “How Long is the Coast of Britain?”, The Fractal Geometry
of Nature, W.H. Freeman and Company, New York, 1983, Chapter 5, p. 25.

8.2 The Sierpinski triangle

One example of a fractal is the Sierpinski triangle. Begin with an equilateral triangle.
Subdivide it into four smaller equilateral triangles and remove the central triangle. Repeat
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this process with the remaining triangles, etc. See the pictures and the movies in the POV-
Ray examples on the website.

One of the movies illustrates the “self-similar” nature of the fractal—that when you zoom
in on one of the corners by a factor of two, the resulting view appears the same as in the
original fractal. Study the POV-Ray source files to see how this fractal is generated. The
program begins with an equilateral triangle, centered at the origin. Then it is shrunk by
a factor of two and translated in three directions into the corners occupied by the original
triangle. The new shape is defined to be the union of these three. This shrinking and
translation process is then applied to the new shape to get the next stage. Repeat this for
as many times as you wish—ideally, an infinite number of times.

8.3 The Snowflake Curve

Exercise 8.2 The Snowflake Curve is an example of a fractal. Begin with an equilateral
triangle. Let’s assume that each side of the triangle has length one. Remove the middle
third of each line segment and replace it with two sides of an “outward-pointing” equilateral
triangle of side length 1/3. Now you have a six-pointed star formed from 12 line segments
of length 1/3. Replace the middle third of each of these line segments with two sides of
outward equilateral triangle of side length 1/9. Now you have a star-shaped figure with 48
sides. Continue to repeat this process, and the figure will converge to the “Snowflake Curve.”
Shown below are the first three stages in the construction of the Snowflake Curve. A picture
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of a later stage can be found in the POV-Ray examples on the website. Study the POV-Ray
source file to see how this fractal is generated.
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1. In the limit, what is the length of the Snowflake Curve?

2. In the limit, what is the area enclosed by the Snowflake Curve?

8.4 Other Examples

Look at the example of the “Fractalsphere” in the POV-Ray examples. Here, a central sphere
is shrunk and translated in six directions to make the new object, and then this operation
is repeated. Fetch the source file and try changing various parameters, including the basic
shape.
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8.5 Fractional Dimension

Exercise 8.3 How should we define the notion of dimension of a set?

Exercise 8.4 Let S be a line segment. If we obtain the line segment S ′ by scaling S up by
a factor of k (multiplying all distances between points of S by k, we can dissect S ′ into k
copies of S. What happens if we try this again when S is a square? What happens if we try
this again when S is a cube? How can we use these results to motivate a definition of the
dimension of these objects?

Exercise 8.5 When we scale the Sierpinski triangle by a factor of two it can be decom-
posed into three copies of the original fractal. What does this suggest the dimension of the
Sierpinski triangle is?

Exercise 8.6 Now consider S to be one of the three “sides” of the snowflake curve, generated
from one of the three sides of the original equilateral triangle. Show that when S is scaled
by a factor of 3, obtaining S ′, we can dissect it into four copies of S. What does this suggest
the dimension of the boundary of S is?
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Exercise 8.7 What is the dimension of the surface of the Fractalsphere? Is it a fractal?

9 Introduction to Animations with POV-Ray

The key to animations in POV-Ray is the variable “clock”. If you use this variable as a
parameter in your POV-Ray file, you can then have POV-Ray generate a sequence of images
with changing values of clock. With this you can, for example, cause the camera, lights, and
objects to move, and change many other things. Look at the sample movies in the POV-Ray
examples and study the source files to see what is going on.

POV-Ray for the Mac operating system allows you to make Quicktime movies fairly
easily. With the POV-Ray file open, select “Edit→Settings”. Click “Output” and select
“QT Movie (Mac OS)”. Then click “Animation”, select “Clock Animation”, and then type
in the desired values for the initial and final frame values, and the initial and final clock
values. Close the settings file and render.

Things are not quite so easy for Windows systems, but it isn’t horribly complicated.
First you will use POV-Ray to generate a sequence of images. Then you must use some
other program to assemble them into a movie.

Determine starting and ending clock for your movie, values, say 0.5 to 2.5. Determine
starting and ending frame values, say 1 to 10. Open the file within POV-Ray. Let’s assume
it is called pretty.pov. Select “Render→Edit Settings/Render”. A window will open. In the
space in the lower half labeled “Command line options” type: +KFI1, +KFF10, +KI0.5,
+KF2.5. Don’t forget to include spaces after the commas. The commands +KFI1 and
+KFF10 set the values of the initial and final frames, respectively. The commands +KI0.5,
+KF2.5 set the values of the initial and final clock values, respectively. POV-Ray will
generate a sequence of images, in this case, pretty01 to pretty10. On my computer they
come out as bmp files. For organizational convenience, make a new folder called pretty and
put all of these files into it.

One way to assemble these images into a movie is to use Windows Movie Maker. Instruc-
tions for getting this are here:

www.microsoft.com/windowsxp/downloads/updates/moviemaker2.mspx.

Start this program. Use “File→Import into Collections”, highlight the images pretty01 to
pretty10 (click on the first one, then hold the shift key and click on the last one). The
pictures should appear in the “Collection” window. Click on the first picture. Now use
“Edit→Select All”, and then click and drag the collection of images to the “Video” strip at
the bottom of the screen. You should now be able to preview the movie at the right side
of the screen. To save your movie, use “File→Save Movie File”. You can then select “My
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computer”, click “Next”, specify the name and location to save the movie, and save it as a
wmv file, which can be viewed by the Windows Media Player.

10 Making AVI Files

Another way to make a movie is to use the program “ImageToAVI” to assemble the
individual images into an avi file. You can fetch this program from the website
www.aswsoftware.com/products/imagetoavi/imagetoavi.shtml.

11 A Comment on Radians

We have already observed in class that POV-Ray interprets commands like “rotate
〈10, 20, 30〉” as first rotating 10 degrees about the x-axis, then 20 degrees about the y-
axis, and finally 30 degrees about the z axis. However, if you use the command “cos(10)”,
the number 10 is interpreted as radians, not degrees. If you want the cosine of 10 degrees
you can use the command “cos(10*pi/180)” or the command “cos(radians(10))”.

Perhaps you may remember that 180 degrees is the same as π radians. Why is this?
Measuring angles in radians is motivated by looking again at the unit circle. The measure
of an angle (in radians) is then simply the length of the arc of the circle subtended (cut out)
by that angle. Since the total circumference of a circle of radius 1 is 2π, then an angle of
180 degrees subtends an arc of length π, an angle of 90 degrees subtends an arc of length
π/2, etc.

12 Visualizing Four Dimensional Objects

We can start trying to visualize some four dimensional objects by using the tools of pro-
jections, cross-sections, and unfoldings. You can see examples in Flatland and Beyond the
Third Dimension.

12.1 Projecting the Cube

Let’s start first by thinking about visualizing a cube (a three-dimensional object) in the
plane (a two-dimensional space). What do various projections of the framework (vertices
and edges) of the cube look like? Look at POV-Ray examples cubeproj1 through cubeproj4.
How are these projections helpful or unhelpful in understanding the structure of the cube?
Now look at POV-Ray example cubeproj5. This is the same as cubeproj2, but now the light
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source is much closer. How does the projection change? Notice that the various edges of the
cube no longer intersect each other in the projection, except where they are naturally joined
at their endpoints. Such a projection is called a Schlegel diagram. What information about
the structure of the cube can you glean from the Schlegel diagram? Can you tell that it has
8 vertices, 12 edges, and 6 faces? Can you tell that the faces are squares?

Try to sketch Schlegel diagrams for the tetrahedron, octahedron, icosahedron, and do-
decahedron. Try to construct them out of Zome System. Now try to make some Schlegel
diagrams for some of the semiregular polyhedra.

12.2 Cross-Sections of the Cube

Imagine that you are a Flatlander and a cube passes through your universe. What
sequence of cross-sections will you see? Of course, this will depend upon the
orientation of the cube as it passes through your plane. You can see these
various cross-sections at the website National Library of Virtual Manipulatives,
http://matti.usu.edu/nlvm/nav/vlibrary.html. Click the box for “Geometry 9–12”
and then click “Platonic Solids - Slicing”. What kinds of cross-sections do other objects
generate? For a perhaps unsettling video of a human being passing through a plane, see
http://www.nlm.nih.gov/research/visible/mpeg/umd_video.mpg.

12.3 Unfolding the Cube

There is more than one way to unfold the cube flat as a connected set of polygons in the
plane by disconnecting certain of its squares. The result is sometimes called a net. Here is
one example:
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How many others can you fine? Try to construct nice nets of the other Platonic solids,
and also some of the semiregular solids.

12.4 Four-Dimensional Regular Polytopes

Looking at the net for the cube, you can see how three squares do not fit snugly together
around a common vertex while lying in the plane. But by lifting the net into three dimensions,
the three squares sharing a common vertex can be glued together. This may help your initial
visualizations of four-dimensional regular polyhedra. Just as we make three-dimensional
regular polyhedra using copies of a common two-dimensional regular polygons as faces, with
the same number of faces meeting at each vertex, so do we make four-dimensional regular
polyhedra out of copies of the various Platonic solids.

Visualize three cubes sharing a common edge:
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The dihedral angles (angle between two adjacent square faces) of each of the three cubes
meeting at the common edge do not sum to 360 degrees, only 270 degrees. But they can
be joined snugly around a common edge if we fold them in four-dimensional space. This
is the beginning of the four-dimensional cube, or hypercube, which has as its faces eight
three-dimensional cubes, four meeting at each vertex, three meeting at each edge.

12.5 Schläfli Symbols

Schläfli symbols are a notation to help keep track of the structure of regular polyhedra,
starting with ordinary two-dimensional regular polygons. The Schläfli symbol for a polygon
with n sides is simply {n}.

For the (convex) Platonic or regular three-dimensional polyhedra constructed of regular
p-gons with q meeting at each vertex the Schläfli symbol is {p, q}:

Platonic Solid Schläfli Symbol
Tetrahedron {3, 3}
Cube {4, 3}
Octahedron {3, 4}
Dodecahedron {5, 3}
Icosahedron {3, 5}
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Notice that if the Schläfli symbol is {p, q}, then each face is a regular p-gon, and by
truncating any vertex we can get a cross-section that is a regular q-gon.

It turns out that we can fit three, four, or five regular tetrahedra around a common edge,
but there is no room for a sixth. Similarly we can fit three octahedra, three cubes, or three
dodecahedra around a common edge, but no more. We cannot fit even three icosahedra
around a common edge. These six possibilities can be folded up and extended in four
dimensions to create the complete list of the six convex regular four-dimensional polytopes (it
has become conventional to use the term polytope for higher dimensional bounded polyhedra):

Polyhedron Faces At Each Edge At Each Vertex Schläfli Symbol
5-cell 5 tetrahedra 3 tetrahedra 4 tetrahedra {3, 3, 3}
8-cell 8 cubes 3 cubes 4 cubes {4, 3, 3}
16-cell 16 tetrahedra 4 tetrahedra 8 tetrahedra {3, 3, 4}
24-cell 24 octahedra 3 octahedra 6 octahedra {3, 4, 3}
120-cell 120 dodecahedra 3 dodecahedra 4 dodecahedra {5, 3, 3}
600-cell 600 tetrahedra 5 tetrahedra 20 tetrahedra {3, 3, 5}

The 5-cell is also known as the four-dimensional simplex, the 8-cell as the four-dimensional
hypercube, and the 16-cell as the four-dimensional cross polytope.

Suppose that the Schläfli symbol of a regular polytope is {p, q, r}. Notice that the first
pair of numbers, {p, q}, describes the face of the polytope. It turns out that the last pair of
numbers, {q, r}, describes what cross-section results when a vertex is truncated, and that this
must also be a regular polytope. This severely limits the possibilities for Schläfli symbols,
keeping the list to a manageable size.

13 Matrices

In Section 7.3 we developed the formulas for rotating a point about the origin in the plane.
If the point (x1, y1) is rotated by the angle δ to obtain the point (x2, y2), then the formulas
are:

x2 = x1 cos δ − y1 sin δ
y2 = x1 sin δ + y1 cos δ

The general form of these equations is:

x2 = ax1 + by1

y2 = cx1 + dy1

System 1
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We will need to know what happens as a result of two such transformations, such as two
rotations about the origin, so let’s consider a second transformation:

x3 = ex2 + fy2

y3 = gx2 + hy2

System 2

What is the net effect of performing these two transformations one after the other? We
can figure this out by substitution:

x3 = ex2 + fy2

= e(ax1 + by1) + f(cx1 + dy1)
= (ea + fc)x1 + (eb + fd)y1

y3 = gx2 + hy2

= g(ax1 + by1) + h(cx1 + dy1)
= (ga + hc)x1 + (gb + hd)y1

System 3

We can represent each of these systems by recording the coefficients of the variables in
an array or matrix :

M1 =

[
a b
c d

]
, M2 =

[
e f
g h

]
, M3 =

[
ea + fc eb + fd
ga + hc gb + hd

]
.

This motivates the definition of the multiplication of matrices. The matrix M3 results
from multiplying M2M1 in that order:

[
e f
g h

] [
a b
c d

]
=

[
ea + fc eb + fd
ga + hc gb + hd

]
.

In general, if matrices AB = C, then the entry in row i, column j of matrix C is the
result of taking the dot product of row i of matrix A and column j of matrix B. So, for
example, the entry in row 2, column 1 of M3 = M2M1, namely, ga + hc, is the dot product
of row 2 of M2 and column 1 of M1:

[
g h

]
·
[

a
c

]
= ga + hc.
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In general, any two matrices A and B can be multiplied if the number of columns of A
equals the number of rows of B. For example:


a11 a12 a13

a21 a22 a23

a31 a32 a33

a41 a42 a43







b11 b12

b21 b22

b31 b32




=




a11b11 + a12b21 + a13b31 a11b12 + a12b22 + a13b32

a21b11 + a22b21 + a23b31 a21b12 + a22b22 + a23b32

a31b11 + a32b21 + a33b31 a31b12 + a32b22 + a33b32

a41b11 + a42b21 + a43b31 a41b12 + a42b22 + a43b32


 .

Both Systems 1 and System 2 can themselves be represented by matrix multiplication of
a 2 × 2 matrix by a 2 × 1 matrix:[

x2

y2

]
=

[
a b
c d

] [
x1

y1

]

System 1

[
x3

y3

]
=

[
e f
g h

] [
x2

y2

]

System 2

It turns out that matrix multiplication satisfies the associative law, so we can combine
these two systems to get the net result:[

x3

y3

]
=

[
e f
g h

] [
x2

y2

]

=

[
e f
g h

] ([
a b
c d

] [
x1

y1

])

=

([
e f
g h

] [
a b
c d

]) [
x1

y1

]

=

[
ea + fc eb + fd
ga + hc gb + hd

] [
x1

y1

]
.
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14 Maple

Maple is a powerful computer algebra system that permits symbolic manipulation and much,
much more. We will begin building up some Maple examples in the course website. There
are also free computer algebra systems available. One of them is Maxima, which can be
obtained from the website http://maxima.sourceforge.net.

15 Computing Cross-Sections of Three-Dimensional

Polytopes

Let’s begin to think about how we can compute what the cross-section of a convex three-
dimensional polytope Q with a plane is. We will assume that we know the coordinates of the
vertices of Q, which pairs of vertices form the edges of Q, and which sequences of vertices
form the polygons of Q. Our plane will have some given equation ax + by + cz = d.

For example, we may have the standard cube with vertices (±1,±1,±1) and the plane
−x − 2y + 4z = 1.

First of all, what can a cross-section look like?

1. If the plane does not intersect Q, the cross-section will be the empty set.

2. It is possible that the plane touches only one point of Q, in which case the cross-section
point will be a vertex of Q.

3. It is possible that the plane touches only one edge of Q.

4. It is possible that the intersection is one of the polygonal faces of Q.

5. And finally, it is possible that the plane cuts through the interior of Q.

In order to determine which case occurs we first classify all the vertices of Q according
to whether they lie on the plane, or on one side, or the other. We do this by substituting
the coordinates for the vertices into the equation of the plane. If the equation is satisfied
with equality, the vertex is on the plane. Otherwise the expression ax + by + cz is less than,
or greater than, the number d. If ax + by + cz < d for a vertex (x, y, z), let’s say the vertex
is on side 1. If ax + by + cz > d, let’s say the vertex is on side 2.

For example, let’s classify the vertices of the standard cube above with respect to the
plane −x − 2y + 4z = 1.

1. A = (1, 1, 1) — on the plane
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2. B = (1, 1,−1) — on side 1

3. C = (1,−1, 1) — on side 2

4. D = (1,−1,−1) — on side 1

5. E = (−1, 1, 1) — on side 2

6. F = (−1, 1,−1) — on side 1

7. G = (−1,−1, 1) — on side 2

8. H = (−1,−1,−1) — on side 1

In general, here are the possibilities:

1. All vertices lie on side 1, or all vertices lie on side 2 — the intersection is the empty
set.

2. One vertex lies on the plane, and the rest all lie on side 1, or the rest all lie on side 2
— the intersection is a single point.

3. Two vertices line on the plane, and the rest all lie on side 1, or the rest all lie on side
2 — the intersection is a single edge.

4. All of the vertices of a polygonal face of Q lie in the plane, and the rest all lie on side
1, or the rest all lie on side 2 — the intersection is that single face of Q.

5. At least one vertex lies on side 1, and at least one vertex lies on side 2 — the plane
cuts through the interior of Q.

It is the last case above that requires more work. Let’s call the cross-section—which is a
polygon—P . We need to figure out the coordinates of the vertices of P , and determine what
the edges of P are. What are the vertices of P? They will either be vertices of Q contained
in the plane, or else they will be the points where edges of Q intersect the plane. The edges
of Q that intersect P can be identified as those edges having one endpoint on one side of the
plane, and the other vertex on the other side of the plane.

Continuing with our example above, we can see that the following edges intersect the
plane at an interior point of the edge: CD, EF , and GH.

If we know that an edge A1A2 crosses a plane ax+by+cz = d, how can we determine the
coordinates of the point of intersection? The answer is to write the description of the line
through A1 and A2 in parametric form and substitute into the equation of the plane. Let’s
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say the coordinates of the endpoints of the edge are A1 = (x1, y1, z1) and A2 = (x2, y2, z2).
The parametric form of the line is given by A1 + t(A2 − A1), where t is a variable. This
expands to (x1, y1, z1) + t(x2 − x1, y2 − y1, z2 − z1) or (x1 + t(x2 − x1), y1 + t(y2 − y1), z1 +
t(z2 − z1)). For example, the parametric form of the line through (1, 2, 3) and (1, 6,−8) is
(1 + t(1 − 1), 2 + t(6 − 2), 3 + t(−8 − 3)) or (1, 2 + 4t, 3 − 11t). As the value of t ranges
over all real numbers we obtain all of the points on the line. When t = 0 we get the original
point A1; when t = 1 we get the original point A2; when t = 1/2 we get the midpoint of the
line segment A1A2; and so on. When we substitute the expression for the parametric form
of the line into the equation of the plane and solve for t, we can then use this value of t to
determine the point of intersection of the line and the plane.

Let’s continue with our example.

1. Segment CD. Parametric form: (1,−1, 1 − 2t). Substitute into −x − 2y + 4z = 1 to
get −1 + 2 + 4(1 − 2t) = 1 or 5 − 8t = 1 or t = 1/2. Substituting this value of t back
into the parametric form yields the point I = (1,−1, 0).

2. Segment EF . Parametric form: (−1, 1, 1 − 2t). Substitute into −x − 2y + 4z = 1 to
get 1 − 2 + 4(1 − 2t) = 1 or 3 − 8t = 1 or t = 1/4. Substituting this value of t back
into the parametric form yields the point J = (−1, 1, 1/2).

3. Segment GH. Parametric form: (−1,−1, 1− 2t). Substitute into −x− 2y + 4z = 1 to
get 1 + 2 + 4(1 − 2t) = 1 or 7 − 8t = 1 or t = 3/4. Substituting this value of t back
into the parametric form yields the point K = (−1,−1,−1/2).

Now that we know how to determine the vertices of the cross-section P , how can we
determine its edges? To get the edges of P , join each pair of vertices of P that lie on a
common polygon of the original polytope Q.

In our example:

1. Points A and I both lie on square ABCD, so AI is an edge of P .

2. Points J and K both lie on square EFGH, so JK is an edge of P .

3. Points A and J both lie on square ABEF , so AJ is an edge of P .

4. Points I and K both lie on square CDGH, so IK is an edge of P .

Thus we conclude that the cross-section P is the polygon AIKJ with vertices A = (1, 1, 1),
I = (1,−1, 0), K = (−1,−1,−1/2), and J = (−1, 1, 1/2).
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16 Projecting Points from Three Dimensions onto a

Plane

At the conclusion of the previous example we had found the coordinates of the four ver-
tices of a cross-section P of a three-dimensional polytope Q. We can plot these points in
three-dimensional space, but perhaps we want to project them onto the plane and get two-
dimensional coordinates with respect to this plane so that we can plot them on, say, a sheet
of graph paper, or on a computer screen.

16.1 Coordinates

To start, we need to understand a bit more what it means to say that we have coordinates of
a point A with respect to a set of directions or vectors. For example, what does it mean to
say that A has coordinates (2, 3,−4) in the sense that we are used to? We can say that A can
be written as a linear combination of the vectors u = (1, 0, 0), v = (0, 1, 0), and w = (0, 0, 1);
namely, (2, 3,−4) = 2u + 3v − 4w. The coefficients 2, 3,−4 of the linear combination give
the coordinates of A.

We can use this idea to get the coordinates of a point in terms of other nonzero vectors
u, v, w. It will be helpful to assume in advance that u, v, w are mutually perpendicular;
i.e., that their mutual dot products are all zero. We saw the dot product before when we
developed the formula in Exercise 7.12. The dot product of (x1, y1, z1) and (x2, y2, z2) is
defined to be (x1, y1, z1) · (x2, y2, z2) = x1x2 + y1y2 + z1z2. When this number is zero the two
vectors are perpendicular because the cosine of the angle between them is zero. For example,
we can take u = (1, 2, 3), v = (−2, 1, 0), and w = (−3,−6, 5). You can check that u · v = 0,
u · w = 0, and v · w = 0. To express (2, 3,−4) as a combination of u, v, w, let’s write

(2, 3,−4) = e(1, 2, 3) + f(−2, 1, 0) + g(−3,−6, 5).

To find e, take the dot product of both sides with u = (1, 2, 3) to get −4 = e(14)+f(0)+g(0)
or e = −2/7. To find f , take the dot product of both sides with v = (−2, 1, 0) to get
−1 = e(0) + f(5) + g(0) or f = −1/5. To find g, take the dot product of both sides with
w = (−3,−6, 5) to get −44 = e(0)+ f(0)+ g(70) or g = −22/35. You can check that indeed

(2, 3,−4) =
−2

7
(1, 2, 3) +

−1

5
(−2, 1, 0) +

−22

35
(−3,−6, 5).

You should see from the above calculations why it might also be nicer for u, v, and
w to be unit vectors (have length 1); i.e., u · u = 1, v · v = 1, and w · w = 1. If we

divide a vector u = (x1, y1, z1) by its length—its distance from the origin—
√

x2
1 + y2

1 + z2
1 ,
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then we get a unit vector u. For example, the length of u above is
√

14 and the vector
u = (1/

√
14, 2/

√
14, 3/

√
14) is a unit vector.

So if A = eu + fv + gw where u, v, and w are mutually perpendicular unit vectors,
then taking dot products on both sides with u, v, and w yields A · u = e, A · v = f , and
A · w = g. Thus the coordinates of A with respect to u, v, w are obtained simply by taking
the dot products with respect to u, v, and w. A set of three mutually perpendicular vectors
in three-dimensional space is called an orthonormal system for the space.

16.2 Projecting onto a Plane

So what does all this have to do with projecting points in three-dimensional space onto a
place and getting new coordinates with respect to that plane? Suppose a plane has equation
ax + by + cz = d and we want to think of the plane as a two dimensional space and obtain
coordinates for a point A with respect to a two-dimensional coordinate system within that
plane? The solution is:

1. Find a vector w perpendicular to the plane.

2. Find two more nonzero vectors u and v perpendicular to w and perpendicular to each
other.

3. Divide u and v by their lengths to obtain unit vectors u and v.

4. Find the coordinates of A with respect to u and v by calculating A · u and A · v.

Why are we ignoring the coordinate of A with respect to w? Because it is a direction
perpendicular to the plane, and we do not care about the distance of the point A from the
plane when we want the coordinates of A with respect to two perpendicular directions within
(parallel to) the plane.

How do we get w? If the plane has equation ax + by + cz = d we can take w = (a, b, c).
For example, if the equation of the plane is −x − 2y + 4z = 1, take w = (−1,−2, 4).

How do we get u? If w = (a, b, c) and a and b are not both zero, we can take u = (b,−a, 0).
For example, if w = (−1,−2, 4) we can take u = (−2, 1, 0). If both a and b are zero, we can
take u = (1, 0, 0).

How do we get v? We can take the cross product of w and u. The cross product of two
vectors w = (w1, w2, w3) and u = (u1, u2, u3) is defined to be the vector

w × u = (w2u3 − w3u2, w3u1 − w1u3, w1u2 − w2u1).
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It should be possible for you to check by dot products that the cross product is perpendicular
to both w and u. In our example, the cross product of w = (−1,−2, 4) and u = (−2, 1, 0) is
v = (−4,−8,−5).

Once we have u and v we can divide by their respective lengths to get unit vectors u and
v, and then get the coordinates of any point A in three-dimensional space with respect to
the plane by taking the dot products (A · u,A · v).

Referring back to the example in the Section 15, we can compute the coordinates of the
vertices of quadrilateral P with respect to the plane −x − 2y + 4z = 1:

1. u = (−2√
5
, 1√

5
, 0).

2. v = ( −4√
105

, −8√
105

, −5√
105

).

3. A = (1, 1, 1) has coordinates (−1√
5
, −17√

105
).

4. I = (1,−1, 0) has coordinates (−3√
5
, 4√

105
).

5. K = (−1,−1,−1/2) has coordinates ( 1√
5
, 29

2
√

105
).

6. J = (−1, 1, 1/2) has coordinates ( 3√
5
, −13

2
√

105
).

Not very pretty, but at least we (or a computer) can do the calculations! You can check
(I have!) that the distance AI is the same with respect to the original three-dimensional
coordinates and with respect to the new two-dimensional coordinates, and similarly with
the other three distances IK, KJ , and JA.

17 Projecting Points from Four Dimensions into Three

Dimensions

The process to project a four dimensional point A along a direction w = (a, b, c, d) and
obtain three-dimensional coordinates is analogous to the process of the previous section:

1. Find three nonzero vectors t, u, and v perpendicular to w and perpendicular to each
other. This turns out to be easier in four dimensions than in three dimensions! You
can simply set:

• t = (d, c,−b,−a).

• u = (−c, d, a,−b).
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• v = (b,−a, d,−c).

You should check by taking dot products that t, u, v, and w are mutually perpendicular
(have dot product zero with each other).

2. Divide t, u, and v by their lengths to obtain unit vectors t, u, and v.

3. Find the coordinates of A with respect to t, u, and v by calculating A · t, A · u, and
A · v.

So for example, to project the point A = (1, 1, 1, 1) in the direction w = (1, 2, 3, 4), we
calculate:

1. t = (4, 3,−2,−1).

2. u = (−3, 4, 1,−2).

3. v = (2,−1, 4,−3).

In each case the length is
√

12 + 22 + 32 + 42 =
√

30, so we have

1. t = (4, 3,−2,−1)/
√

30.

2. u = (−3, 4, 1,−2)/
√

30.

3. v = (2,−1, 4,−3)/
√

30.

Therefore, the projected coordinates of A = (1, 1, 1, 1) are:

1. (1, 1, 1, 1) · (4, 3,−2,−1)/
√

30 = 4/
√

30.

2. (1, 1, 1, 1) · (−3, 4, 1,−2)/
√

30 = 0.

3. (1, 1, 1, 1) · (2,−1, 4,−3)/
√

30 = 2/
√

30.

Thus the projected point has coordinates (4/
√

30, 0, 2/
√

30).
Refer to the POV-Ray examples that I have prepared for some projections of the hyper-

cube.
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18 Coordinates for Some Regular Four-Dimensional

Polytopes

18.1 The 5-Cell

We can think of the 5-cell as a pyramid over a three-dimensional tetrahedron. We begin
with coordinates of vertices of a tetrahedron centered at the origin by taking every other
vertex of a cube centered at the origin, and then appending a fourth coordinate of zero:

1. A = (−1,−1,−1, 0).

2. B = (−1, 1, 1, 0).

3. C = (1,−1, 1, 0).

4. D = (1, 1,−1, 0).

To find the apex of the 5-cell we need a fifth point E = (0, 0, 0, z) so that all pairwise
distances between these five points are equal. We can find z by equating the distances AB
and AE, for example:

AB =
√

02 + 22 + 22 + 02 =
√

8

AE =
√

12 + 12 + 12 + z2 =
√

3 + z2√
8 =

√
3 + z2

8 = 3 + z2

5 = z2

z =
√

5

Thus E = (0, 0, 0,
√

5). All pairs of these five points are joined by edges of the 5-cell, for a
total of 10 edges. All triples of these five points determine a triangular face of the 5-cell,
for a total of 10 triangles. Every subset of size 4 determines a tetrahedral three-dimensional
face of the 5-cell, for a total of 5 tetrahedra.

Now you have enough information to use POV-Ray to create some projections.

18.2 The 8-Cell

The sixteen vertices of the 8-cell, or hypercube, are obtained by taking points of the form
(±1,±1,±1,±1). Two points are joined by an edge if they agree in exactly three coordinates.
So for example, (1,−1, 1, 1) and (1,−1, 1,−1) determine an edge. There is a total of 32
edges. Four vertices determine a square if they agree in exactly two coordinates. So for
example a square is determined by the following four points, in the given order: (1,−1, 1, 1),
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(1,−1, 1,−1), (−1,−1, 1,−1), (−1,−1, 1, 1). There is a total of 24 squares. Eight vertices
determine a cube of the hypercube if they agree in exactly one coordinate. So for example,
the vertices (±1,−1,±1,±1) form the vertices of a cubical face. There is a total of eight
cubes.

Refer to the POV-Ray examples of projections of the hypercube, and make some more
of your own.

18.3 The 16-Cell

The 16-cell is the four-dimensional analogue of the octahedron, so let’s look at the octahedron
for a moment.
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If we bring one face of the octahedron close to one eye, we can visualize the structure of the
octahedron as a large equilateral triangle with a smaller one inverted within it. The result
is a Schlegel diagram of the octahedron:
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A

E C

D

B

F

The coordinates of the vertices of the octahedron are:

A = ( 1, 0, 0 )
B = ( −1, 0, 0 )
C = ( 0, 1, 0 )
D = ( 0, −1, 0 )
E = ( 0, 0, 1 )
F = ( 0, 0, −1 )

Each vertex is joined to every vertex except its opposite. So A is not joined to B, but is
joined to every other vertex.

In like manner, we can visualize the 16-cell as one tetrahedron inverted within another.
The coordinates of the eight vertices are (±1, 0, 0, 0), (0,±1, 0, 0), (0, 0,±1, 0), (0, 0, 0,±1).
Each vertex is joined to every other vertex except its opposite, resulting in 24 edges. Every
triple of vertices not containing any opposite pairs of vertices forms a triangle, and there are
32 of these. Every subset of size four not containing any opposite pairs of vertices forms a
tetrahedral face, resulting in 16 tetrahedra.

Now you have enough information to use POV-Ray to create some projections.

18.4 The 24-Cell

The 24 cell consists of 24 octahedra, and the coordinates of its vertices are a bit harder to
visualize. It turns out that you can take the vertices to be the centers of the squares of a
hypercube. The hypercube has 24 squares, so the 24-cell has 24 vertices. For example, the
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center of the square (1,−1, 1, 1), (1,−1, 1,−1), (−1,−1, 1,−1), (−1,−1, 1, 1). can be found
by taking the average of the coordinates of the four corners, yielding the point (0,−1, 1, 0).

Now focus on just one of the cubes of the hypercube. The centers of its six squares are
six of the vertices of the 24-cell. These six vertices can be joined by 12 edges to form an
octahedron inscribed within the cube.

For example, looking at the cube with vertices

( 1, −1, 1, 1 )
( 1, −1, 1, −1 )
( 1, −1, −1, 1 )
( 1, −1, −1, −1 )
( −1, −1, 1, 1 )
( −1, −1, 1, −1 )
( −1, −1, −1, 1 )
( −1, −1, −1, −1 )

we can figure out that the centers of its squares have coordinates

A = ( 1, −1, 0, 0 )
B = ( −1, −1, 0, 0 )
C = ( 0, −1, 1, 0 )
D = ( 0, −1, −1, 0 )
E = ( 0, −1, 0, 1 )
F = ( 0, −1, 0, −1 )

Each point is joined to all but its opposite, so for example A is joined to C, D, E, and F .
Doing this for each of the eight cubes of the hypercube will create a total of 96 edges. It

turns out that these form a complete set of edges of the 24-cell, but we only get eight of the
24 octahedra.

Starting with this information, try to get POV-Ray to make some images of projections
of the 24-cell. Can you figure out where the other 16 octahedra are?

19 Central Projection

In Section 16 we discussed how to take points in three dimensions and project them onto
a two-dimensional space along a direction (a, b, c). The projection was orthogonal in the
sense that we were projecting our points in an orthogonal or perpendicular direction onto
our plane defined by the equation ax + by + cz = 0. We found coordinates of the projected
point with respect to two perpendicular vectors u and v within the plane.
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There are some limitations to visualizing three-dimensional objects using this projection,
however. For example, any orthogonal projection we make of a cube into a plane will result
in overlapping images of its constituent squares.
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We cannot get the classic “square-within-a-square” projection of a cube by orthogonal
projection. But we can do this with central or perspective projection..

Imagine holding up a transparent cube very close to one eye and looking into one of its
square faces. The image that you see will be framed by this particular square face, and all
of the other faces of the cube appear within it—a nice Schlegel diagram.

If we do the same for an octahedron, we get the “triangle-within-a-triangle” Schlegel
diagram shown in Section 18.2. The projected image is framed by one of the triangles of
the octahedron, and the other seven triangles are non-overlapping. Thus it is easier to
understand the structure of the octahedron from this projected image.

What is the mathematics behind this? What we will do is project a point P = (x, y, z)
onto a plane with equation ax+by+cz = e, with e �= 0, by drawing a line through P and the
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origin O = (0, 0, 0) and determining the point Q of intersection of this line with the plane.
(We require e �= 0 to avoid having all points P project to the same point O.)
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•P

•O

•Q

Artists employed sometimes literally employed this technique to
paint and draw in perspective. See, for example, the website
www.acmi.net.au/AIC/DRAWING_MACHINES.html.

Mathematically this is not hard to do. The line through P and O consists of points of the
form Q = (kx, ky, kz). We need to find for which value of k this point satisfies the equation
of the plane. By substitution, akx + bky + ckz = e, and so k = e/(ax + by + cz). Thus the
point Q has coordinates

Q =
e

ax + by + cz
(x, y, z). (1)

You may notice that there is a problem if ax + by + cz = 0. In this case the line through P
and O never intersects the plane, and the point Q does not exist.

Once we have the above three-dimensional coordinates of Q, we can proceed as in Sec-
tion 16 to obtain two dimensional coordinates of Q with respect to the direction (a, b, c). We
can repeat this process with other points P to find the central projections of all the points
of a desired structure. The “degree” of perspective will be affected by the relative positions
of the origin, the plane, and the structure. Roughly speaking, the closer the structure is to
the origin, the greater will be the degree of perspective.

Let’s assume that we begin with a structure with points P roughly surrounding the origin,
and that we have a plane ax + by + cz = 0 passing through the origin. We will translate
the structure and the plane together by p(a, b, c), where p is some nonzero number, and then
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we will carry out central projection of the resulting structure onto the resulting plane. The
greater the value of p, the closer central projection will be to orthogonal projection. In the
limit, as p approaches infinity, the result will actually be orthogonal projection.

To carry out the calculations, each of the points P = (x, y, z) will be translated to
(x, y, z) + p(a, b, c) = (x + pa, y + pb, z + pc). The plane ax + by + cz = 0 (and along with it,
the origin O) will also be translated by the amount p(a, b, c). This plane now has equation
ax + by + cz = e for some value of e, and this plane must contain the translation of the
origin, p(a, b, c) = (pa, pb, pc). We can substitute this point into the equation of the plane to
determine e:

e = ax + by + cz
= a(pa) + b(pb) + c(pc)
= p(a2 + b2 + c2).

Now we can use Equation (1) with the translated point (x + pa, y + pb, z + pc) (instead
of (x, y, z)) to carry out the central projection of the translated point (x + pa, y + pb, z + pz)
onto the (translated) plane ax + by + cz = e.

What about perspective views of four-dimensional objects? We use the analogous for-
mulas to do central projection onto a three-dimensional hyperplane. Thinking of our struc-
ture roughly centered at the origin O = (0, 0, 0, 0) and the hyperplane having equation
ax+by+cz+dw = e, compute e = p(a2+b2+c2+d2). Then, for each point P = (x, y, z, w) we
project to the point Q = e

ax+by+cz+dw
(x, y, z, w). After that, we calculate three-dimensional

coordinates of Q as in Section 17.
Here is an example of a perspective view of a hypercube with respect to the direction

(a, b, c, d) = (1, 0, 0, 0), which creates a nice Schlegel diagram.
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Notice that you can see seven of the eight cubical cells within the outer framing cube.
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